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Chapter 1 – Introduction 

This instruction manual provides comprehensive guidance on the 
operation and maintenance of the FM 301 Blasting Seismograph. It 
specifically applies to the updated FM 301 units designated as 
the 2000 Series, which begin with serial number 2000. These 
units feature updated components and interface features that differ 
from the earlier 1000 Series (serial numbers 1000–1999). If your 
seismograph’s serial number is within the 1000–1999 range, please 
refer to the prior version of this manual. 

The FM 301 is a high-performance digital seismograph designed to 
monitor vibration and air overpressure generated by blasting 
operations. Typical applications include surface and underground 
mines, quarries, and other environments involving explosive use. 

Technical specifications for the FM 301 are provided in Appendix 
1. 

 

 

 

 

 

 

 

 

 

 

 

Handling Procedures 

• Handle all equipment and accessories with care. 

• Do not operate the unit if it appears damaged. Power it off 
immediately and return it to an authorised service facility. 

• Ensure all connectors, including USB, are fully inserted and 
clean before use. 

Microphone  L 

 T 

USB Port On/Off Switch 

Indicator 
LED 

Charging 
LED (Red) 
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• Do not pull or force cables. Always align connectors before 
inserting. 

• Charge the battery as soon as a low battery condition is 
indicated. 

• Do not disassemble, puncture, expose to temperatures 
above 60°C (140°F), or incinerate the battery under any 
circumstances. 

Warning: The FM 301 contains a sealed lithium-ion battery. 
Mishandling may cause fire or chemical burn. The battery is 
not user-serviceable and must not be removed by the operator. 

• Do not attempt to open or service the unit. 

• The FM 301 is water-resistant, but must not be submerged. 
Clean with a damp cloth only. 

Vibration Sensors 

The FM 301 uses triaxial accelerometers for vibration 
monitoring. This allows the unit to function accurately in any 
orientation—it does not require levelling to produce valid results. 

Unlike moving-mass geophones, accelerometers offer enhanced 
reliability and durability. The device internally converts 
acceleration to velocity, providing both peak acceleration and 
peak velocity values. 

USB Interface 

The FM 301 includes a USB interface for: 

• Charging the internal battery 

• Connecting to Windows software for data transfer and 
configuration 

The supplied USB cable is required for both communication and 
charging functions. 

Bluetooth 

The FM 301 features a Bluetooth Low Energy (BLE) interface. 
This allows the unit to connect wirelessly to the FM Seismograph 
Android App, enabling remote configuration and event monitoring. 
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Battery Life 

Battery life depends on usage and environmental factors. Typical 
continuous monitoring runtime is approximately 24 hours. 

The battery is charged via the USB port. Charging from a fully 
depleted state takes approximately 12 hours. 

GPS 

The FM 301 includes an integrated GPS receiver. When a GPS 
signal is available: 

• The unit stores the location of each recorded event 

• Timing accuracy is enhanced, enabling synchronisation 
across multiple devices 

Note: GPS position accuracy depends on satellite availability, 
signal blockage, and atmospheric conditions. 

Typical accuracy ranges from 4 to 20 metres. 

Internal Storage 
The unit includes internal memory capable of storing up to 1,000 
full waveform recordings. 

When capacity is reached, the oldest recordings are automatically 
overwritten. 

Dimensions and Weight 
• Dimensions: 160 mm × 138 mm × 55 mm 

• Weight: Less than 1 kg 

Despite its compact form, the FM 301 integrates advanced 
monitoring hardware and robust storage capability in a single self-
contained unit. 

Mounting 
The FM 301 includes: 

• Levelling feet for use on hard surfaces 
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• Ground spikes for deployment on soil 

• Two mounting holes for permanent installation on solid 
structures 

Although orientation does not affect data validity, a built-in spirit 
level is included for optional levelling. 

LED Indicators 
The FM 301 is equipped with two LEDs on the top of the unit: 

• The left LED is a red charging indicator. It illuminates while 
the unit is charging via USB power and turns off when 
charging is complete. 

• The right LED is a multicolour status indicator (red, green, 
blue, white) used to display operational states, GPS lock, 
battery level, trigger events, and data processing. 
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Chapter 2 – Charging 

Charging the seismograph 
Charging of the internal batteries is achieved by connecting to any 
powered USB port with the supplied USB lead.  

When the unit is connected to USB power, the left red LED will 
illuminate to indicate that charging is in progress. 

• The LED will remain on during charging. 

• The LED will automatically turn off once charging is 
complete.  

If the unit is connected to a powered laptop or other computer, 
charging will continue in the background. It can therefore be 
convenient to leave your FM 301 connected to a powered USB port 
when not in use. 

The battery level is indicated when the unit is turned on or can be 
seen using the Android App. Battery level should only be 
assessed when the unit is not being charged via USB. 

Charging from a completely flat battery will take approximately 12 
hours. 

Note: Do not charge the unit overnight or leave it unattended for 
long periods while charging. 
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Chapter 3 – FM 301 Operations 

Setup Monitoring Parameters  
Before going into the field the monitoring parameters should be set 
via the supplied Windows software (see section below). For a 
typical monitoring operation the following parameters are 
recommended: 

• Record Window : 4 seconds 

• Vibration Trigger Level : 0.5 mm/s 

• Air Overpressure Trigger Level : 115 db(Linear) 

Note that the trigger levels can also be changed during monitoring 
via the Android App – see the App section below for more 
information. 

The monitoring parameters are stored in non-volatile memory and 
will be used when the machine is turned on. 

Field Setup 

The FM 301 comes with a set of levelling feet for use on solid 
surfaces and spikes for use in soils.  

Whilst the unit can be operated in any orientation there is a 
levelling bubble included for use if desired. 

Monitoring Start  
With the FM 301 in position, and correctly setup, monitoring can be 
started by turning the machine on via the On/Off button.  

Note : The On/Off button is Off when the button is depressed and 
On when the button is raised. This is to reduce the chance of the 
power being accidently turned on in the carrying case. 

Initial LED Indications 
When the unit is powered on, the right multicolour LED performs 
a startup test to confirm it is functioning correctly. The sequence is 
as follows: 

• Solid white LED for approximately 2 seconds 
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After this, the LED will indicate the battery level using one of the 
following colours: 

• Green – Battery level is good (several hours of monitoring 
available) 

• Blue – Battery level is moderate (approx. one hour 
remaining) 

• Red – Battery is low (less than one hour; unit may stop 
monitoring) 

• Flashing Red – Battery is critically low; charging is 
required before monitoring can begin 

 

Monitoring Process 
Monitoring will continue until the unit is powered down using the 
On/Off button. 

The right multicolour LED indicates monitoring status as follows: 

• Flashing Green – Monitoring active 

• Flashing Blue – Monitoring active with a valid GPS signal 

• Solid Red – Trigger event detected 

• Solid Blue – Data processing and storage in progress  

The LED flashes are synchronised with the recording window. For 
example, if a 4-second window is set, the LED will flash every 4 
seconds. 

If the right LED begins flashing red rapidly, this indicates that 
battery power is insufficient and monitoring has been suspended. 

Note : If low power is indicated, the unit should be turned off 
immediately to avoid running the battery too low, which can 
cause permanent damage. 

 

Monitoring End 
The FM 301 will continue monitoring and automatically store each 
recording to internal memory. When the memory reaches its 
capacity of 1,000 events, the oldest recordings will be overwritten 
in sequence. 

Monitoring can be stopped at any time by pressing the On/Off 
button. 
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Chapter 4 – V-Blast Windows 
Software 

Connecting via a USB Port  
The FM 301 can be connected to any compatible Windows PC using 
the supplied USB charging cable. 

Setting the FM 301 into USB Communication Mode  
Before transferring data to or from the FM 301 via USB, the unit 
must first be placed into USB communication mode. Activating this 
mode disables triggering, allowing the unit to remain powered on 
without false event recordings. 

To enter USB communication mode: 

1. Power on the unit. 

2. During the solid white LED shown at startup 
(approximately 2 seconds), tap the top of the unit twice. 

3. If the taps are registered correctly, the right LED will 
briefly flash white. 

4. After this, the right LED will illuminate solid white, 
indicating that USB mode is active. 

 

• The solid white LED will remain on continuously whilst the 
unit is in USB mode. 

• The LED will change to red during USB data transmission 
(sending or receiving). 

• USB mode remains active until the unit is powered off. 

 

Alternatively, USB mode can be activated by gently shaking the unit 
during the startup LED sequence. 

Running the V-Blast software  
After launching the V-Blast software, the main window will open 
displaying a blank interface with a menu bar. All operations related 
to file management, data download, and configuration are 
accessible via the menu options described in the following sections. 
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File :  Open 

Selecting File → Open allows previously saved waveform files to be 
opened within the software. 

These files use the .FMD extension and contain full waveform 
recordings captured by the FM 301. 

Download 

Selecting Download → Local (USB Connection) opens a new 
window for connecting to an FM 301 device and managing event 
file transfers. 

Once connected, event recordings stored on the unit can be viewed, 
selected, and downloaded to the computer for further analysis or 
archiving. 

 

 

 

 

 

 

 

 

 

 

 

 

When the Download from Seismograph via USB Connection 
window opens, two connection options are available: 

• Auto Connect 

• Select COM Port (manual selection) 
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Before proceeding, ensure the FM 301 is: 

• Connected to the PC using the supplied USB charging cable 

• Powered on and placed in USB communication mode, 
indicated by a solid white right LED 

Note: If the unit is powered on and the right LED is solid white, 
but the software displays "Error: No Valid Comms Port 
found.", the PC has not successfully established communication. 

In this case: 

• Ensure that only one unit is connected 

• Retry using Auto Connect, or manually select the correct 
COM port 

• Check the USB connection and confirm that the unit is 
not still completing its startup sequence  

 

Once the device is ready, click Auto Connect. The software will 
attempt to automatically detect and connect to the FM 301. 

If Auto Connect is unsuccessful, use the Select COM Port drop-
down to manually choose the correct port. 

 

Once a connection is established, the software will display a list of 
the most recent 20 recorded events, including the date, time, and 
peak values for both vibration and air overpressure. 

Additional options are available to view a larger set of events: 

• Last 100 Events – Displays the most recent 100 recordings 

• All 1000 Events – Displays the full history of recordings 
stored in the unit’s memory  

Note: Do not close the window while the event summary is 
loading. Closing the window during this process may cause the 
software and FM 301 to become unresponsive. 

 

The software will also display the serial number of the connected 
FM 301 unit and the assigned COM port. 

To download event files: 

1. Select one or more events from the list using the checkboxes 
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- or  - 

Enter an Event ID into the Event ID input box 

2. Click Download Event(s) 

3. A progress bar will indicate the transfer status 

4. When complete, a file browser will prompt for a destination 
folder 

Warning: Some Events Records Were Invalid and are Not 
Listed 

If the message “Warning: Some Events Records Were Invalid 
and are Not Listed.” appears, this indicates that one or more 
event records could not be displayed in the summary list. 

To attempt recovery of missing events: 

• Close the warning window 

• Review the displayed Event ID list 

• Identify any missing Event IDs 

• Enter each missing ID into the Event ID input box 

• Click Download Event(s) 

If successful, the progress bar will indicate download progress, 
and a file browser will prompt for the destination folder when 
complete. 

 

Multiple recordings can be downloaded simultaneously. All files are 
saved using a standard 18-digit filename format: 

YYYYMMDDHHMMSS####.FMD, where: 

• YYYY = Year 

• MM = Month  

• DD = Day 

• HH = Hour 

• MM = Minute 

• SS = Second 

• #### = Unit serial number 

For example: 
202507221211432010.FMD 
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(Recorded on July 22, 2025 at 12:11:43 by unit 2010) 

It is recommended to organise files by site and location using 
clearly named directories for future reference. 

Setup :  Seismograph 

Before accessing the setup screen, ensure the FM 301 is correctly 
connected and in USB communication mode. 

Failure to do so will result in the error message: 
"Error: No Valid Comms Port found." 

To avoid this, confirm the following: 

• The unit is connected to the PC via the supplied USB 
charging cable 

• The unit is powered on and in USB communication mode 
(indicated by a solid white right LED) 

Once confirmed, select Setup → Seismograph → Local (USB) to 
open the configuration window. 

The initial screen presents two connection options: 

• Auto Connect – Automatically detects the connected FM 
301 

• Select COM Port – Allows manual selection of the 
appropriate COM port 

Once connected, the current configuration of the FM 301 will be 
displayed. 

 

 

 

 

 

 

 

 

The following parameters can be adjusted: 
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• Trigger levels for vibration and air overpressure 

• Recording duration 

• Accelerometer range 

• Trigger enable/disable options for velocity and  air 
overpressure  

Clicking Default Setup will apply the following default settings: 

• Vibration trigger: 0.5 mm/s 

• Air overpressure trigger: 115 dB(L) 

• Duration: 4 seconds 

The Clock section displays the unit’s internal time. The UTC offset 
can be set to reflect the local time zone at the monitoring location. 

Click Send to Seismograph to apply and save the updated 
configuration. 

Setup :  Software 

Selecting Setup → Software opens a window for configuring how 
data is displayed and interpreted within the V-Blast software 
environment. 

The following settings can be adjusted: 

• Colour scheme for waveform displays 

• Units: Metric or Imperial 

• Display of peak resultant values 

• Vibration monitoring standard 

• Air overpressure monitoring standard 

Colour options can be modified by clicking the colour swatch next 
to each parameter. 

Note : The reported peak values for vibration and air 
overpressure are dependent on the selected monitoring standard. 
These may differ from the provisional results shown in the 
Android App. 

 

Note : The original raw waveform data is preserved in the .FMD 
file. Any vibration or overpressure values exported to CSV are 
filtered based on the selected monitoring standards. 
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Waveform Display 

Any .FMD file saved using the V-Blast software can be opened for 
review by selecting File → Open from the main menu. 

The waveform will be displayed in a new window, with graphical 
plots for vibration and air overpressure. By default, the velocity 
trace is shown, but this can be toggled to acceleration using the 
Acceleration button or displacement using the Displacement 
button . 

 

 

 

 

 

 

 

 

 

 

 

 

If a valid GPS signal was present during recording, GPS time pulses 
will appear along the bottom of the display. 

The following information is shown alongside the waveform: 

• Date and time the event was recorded 

• Time source: Either the unit’s internal clock (RTC) or GPS 
signal (UTC) 

• FM 301 serial number 

• Last calibration date 

• GPS coordinates (if available) 

• User comments (up to 4 lines) 

• Comments can be added directly within the display 
window by clicking on a line and typing. 



Blast Log Ltd 15 

  

FM 301 Blasting Seismograph Series 2000 - Instruction Manual    •   15 
 

Note: To save any entered comments, select File → Save. 
Unsaved comments will be lost when the window is 
closed. 

• Results table, including: 

• Peak values for each vibration component (velocity, 
acceleration, displacement) 

• Nominal frequencies 
• Peak air overpressure reading 
• Applied monitoring standards 

The waveform view includes options for: 

• Printing (via the printer icon or PDF export) 

• Zooming (via the magnifying glass icon) 

• Frequency analysis 

• Signal filtering 

Printer Icon 

Clicking the printer icon initiates the print process for the 
displayed waveform and associated data. 

The output will be sent to the default or selected printer connected 
to the computer. 

If a PDF printer is installed, a digital copy of the waveform can be 
generated as a PDF. 

Magnifying Glass Icon – Zoom Function 

Clicking the magnifying glass icon opens the Zoom Tool, which 
provides a detailed view of the waveform for closer inspection. 

• A solid vertical line marks the current signal location 

• The blue slider at the bottom of the window allows 
panning left or right across the waveform. 
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Keyboard Navigation: 

• ← / → : Move one sample at a time 

• Pg Up / Pg Dn : Move in larger increments 

• Home / End : Move to the start or end of the waveform 
 

Clicking the clock icon in the upper-left sets the time at the current 
location to zero, marked by a dashed line. 

Time and frequency values displayed are relative to this point. 

Click the clipboard icon in the upper-right corner to copy the 
displayed data to the computer’s clipboard. 

Frequency Analysis 

Clicking the Frequency Analysis tab opens a window that displays 
the frequency content of the selected waveform segment. 
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A blue slider at the bottom of the window allows panning left or 
right across the signal. 

Keyboard Navigation: 

• ← / → : Move one sample at a time 

• Pg Up / Pg Dn : Move in larger increments 

• Home / End : Move to the start or end of the signal 

Three frequency range options are available: 

• 50 Hz  

• 100 Hz 

• 200 Hz 

A drop-down menu in the upper-right corner allows selection of 
the frequency analysis standard to apply (e.g. USBM RI 8507, 
among others). 
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To generate a hard copy or digital output, click the printer icon. If 
a PDF printer is installed, the analysis can be exported as a PDF.  

Filter 

Clicking the Filter tab opens a new window for applying frequency 
filters to the selected waveform. 
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Available options include: 

• High-pass and low-pass filters 

• Cutoff frequency selection to isolate or remove specific 
frequency ranges 

After selecting the desired filter settings, click Apply Filter. A new 
window will display the filtered signal. 

To revert to the original, unfiltered waveform, click the green 
reverse arrow in the upper-right corner of the screen. 
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Chapter 5 – FM 301 Android App 

Downloading and installing FM Seismograph App  
The FM Seismograph application is available for download via the 
Google Play Store. 

Search for “FM Seismograph” to locate the app. 

Note : Availability may be restricted in certain countries due to 
regional distribution settings. 

 

Using the FM Seismograph App  
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When the FM Seismograph App is launched, the initial screen 
displays a status line at the top of the screen, indicating the current 
connection state. 

For example, if no device is connected, the status will show “No 
Connection.” 

Below the status line is a row of buttons, each representing a key 
function of the app. 

If any buttons are displayed in light grey, the corresponding 
functions are currently disabled. 

Once a connection is established with an FM 301 unit, the help 
screen will be replaced with device status and event data. 

Connect to FM 301 

Pressing the Connect button prompts the app to search for nearby 
FM 301 units using Bluetooth. 

A list of detected devices will be displayed. Each device name 
includes “FM301” followed by a 4-digit serial number, allowing 
identification of the correct unit. 

To improve connection reliability: 

• Remain within 5 metres of the unit 

• Retry the connection process if unsuccessful on the first 
attempt 

Once connected: 

• The status line will update to show the connected FM 301 

• A Data Log table will appear, showing a summary of the 
last 3 recorded events 

• A Seismograph Status panel will display: 

• Serial number 

• Battery level (with colour-coded indicator: green = 
high, yellow = medium, pink = low) 

• Sampling rate 

• Recording window size 

• Trigger levels 

• GPS data 

If the battery level is pink, less than one hour of monitoring 
time remains and the unit may stop recording. 
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If triggering is disabled for vibration and/or air 
overpressure, the field will display “Disabled” on a yellow 
background. 

If no valid GPS signal is available, “No Fix” will be shown; 
otherwise, latitude and longitude will be displayed. 

Note: The displayed information reflects the FM 301’s 
status at the moment of connection and is not updated in 
real time. 

When the FM 301 detects and stores a new event, the app will 
display a notification—even if another app is running in the 
foreground. The Data Log screen will automatically update with the 
new event. 

Note: The reported peak values shown in the app are provisional. 
Final values may differ once processed in the V-Blast software 
using the selected monitoring standard. 

Disconnect from FM 301 

Pressing the Disconnect button will terminate the 
connection between the app and the FM 301 unit. 

The app will return to the initial screen, and all device-specific 
functions will be disabled until a new connection is established. 

Update Log and Status Screens 

Pressing the Update button refreshes the displayed data, including 
the event log and current seismograph status. 

Note : Updating the display momentarily suspends monitoring.  

To avoid missing data, it is recommended not to perform an 
update until after the blast has taken place. 

Adjust Trigger Levels  

Pressing the Adjust Trigger Levels button opens the Trigger 
Settings panel. 

The current trigger levels for vibration and air overpressure are 
displayed, along with up and down arrows for each channel. 
Use these arrows to modify the levels as required. 

After making a change, a Send button (right-facing arrow) will 
appear. Pressing this button transmits the updated settings to the 
FM 301. 
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• If the vibration trigger is set below 0.5 mm/s, a yellow 
background will appear as a warning of increased risk of 
false triggers. 

• For air overpressure, this warning appears when the level is 
set below 108 dB(L). 

Disabling Trigger 

Pressing the Disable Trigger button will immediately turn off 
triggering and suspend the monitoring process. 

This function is intended for use in environments where 
background levels of vibration or air overpressure exceed the 
configured trigger thresholds, causing continuous triggering. 

Once triggering is disabled, the trigger levels can be adjusted as 
needed via the Adjust Trigger Levels panel. 

Send Results by Text Message 

Pressing the Send Results by Text Message button opens a panel 
for sending a summary of recent events via SMS. 

• Select one or more of the three displayed events 

• Enter a Site Name and Monitoring Location (optional 
fields) 

• Choose the recipient's phone number from the device’s 
contact list 

The selected information will be formatted into a text message and 
sent using the phone’s default messaging service. 

View Location on a Map 

Pressing the View Location on a Map button displays the GPS 
location of the FM 301 on an interactive map. 

Note: An active internet connection is required to view the map. 
This function is disabled if no valid GPS fix is available. 

 

Close Application 

Pressing the Close Application button will terminate the app and 
disconnect any active FM 301 connections. 
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All unsaved changes or pending actions will be discarded. 

Adjust App Settings 

Pressing the Adjust App Settings button opens a configuration 
screen where display and notification preferences can be 
customised. 

Available settings include: 

• PPV Units: mm/s (millimetres per second) or i.p.s. (inches 
per second) 

• Air Overpressure Units: Pa (Pascals), dB(L) (decibels 
Linear), mbar (millibars), or psi (pounds per square inch) 

• Date Format: dd/mm/yyyy or mm/dd/yyyy 

• Button Feedback: Enable beep and/or vibration for 
button presses or event notifications 

To apply changes, press Save. The selected preferences will be 
stored for future sessions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Blast Log Ltd 25 

  

FM 301 Blasting Seismograph Series 2000 - Instruction Manual    •   25 
 

Appendix 1 – Specifications 

FM 301 Specifications  

Data Channels 

3 x Acceleration and 1 x Air Overpressure 
3 x Velocity generated by on board integration of acceleration 
channels 

Acceleration Frequency Response  

2.47 Hz to 250 Hz at a sampling frequency of 1.0 kHz 

Air Overpressure Frequency Response  

1 to 250 Hz  

Resolutions (nominal and subject to calibration) 

Acceleration : 0.0374 mm/sec2 
Velocity : 0.01 mm/sec 
Air Overpressure : 0.12 Pa   

Ranges 

Acceleration : 78500 mm/sec2 or 8g 
Velocity : 314 mm/s at 10 Hz to 31.4 mm/s at 100 Hz  
Max. velocity range: +/- 327 mm/s (12.9 in/s) 
Air Overpressure : 1000 Pa or 154 dB(L) 

Triggering  

Vibration velocity : from 0.1 mm/s upwards in 0.1 mm/s steps 
Air overpressure : from 2 Pa (104 dB(L)) upwards in 1 Pa steps  

Pre-Trigger Recording 

Sample Rate 1.0 kHz 

Pre-Trigger 0.512 
seconds 
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Recording Windows 

Sample Rate 2 
second 

4 
second 

8 
second 

1.0 kHz Yes Yes Yes 

Storage Capacity 

1000 full waveform recordings  

Clock 

On-board real time clock accurate to 10 seconds 
GPS clock accurate to better than 1 microsecond  

Interfaces 

USB 2.0 to Windows software 
Bluetooth Low Energy to Android application for mobile devices  

Integrated GNSS 

GPS  

Bluetooth 

FCC IDENTIFIER: SH6MDBT40 
NAME OF GRANTEE: Raytac Corp. 
EQUIPMENT CLASS: Digital Transmission System 
NOTES: Bluetooth Module 
MODULAR TYPE: Single Modular 

Dimensions 

160 mm x 138 mm x 55 mm (6.3 in x 5.4 in x 2.2 in)  

Weight 

0.85 kg 
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V-Blast Specifications  

Minimum Requirements  

Microsoft Windows 10 operating system 

International Vibration Monitoring Standards Included 

AS 2187: 2 to 250 Hz  

BS 7385: 1 to 150 Hz 

ISEE: 2 to 250 Hz  

ISO 4866: 1 to 150 Hz 

International Air Overpressure Monitoring Standards 
Included 

AS 2187: 2 to 250 Hz  

ISEE: 2 to 250 Hz  

Velocity Frequency Damage Criteria Included 

BS 7385 Part 2 

DIN 4150-3  

USBM RI 8507 

OSM CFR 30 

UNE 22-381-93 

 

FM Seismograph App Specifications  

Minimum Requirements  

Android 5 
 

 



  

 

Blast Log FM 301 Blasters’ Seismograph Warranty 
 

The Blast Log FM 301 blasters’ seismograph comes with a one year warranty from the date of 
delivery to the purchaser. The warranty only applies to the original purchaser and is not 
transferrable. This warranty guarantees that any FM 301 unit manufactured or sold by Blast Log 
Limited is free from defect, whether this relates to materials or workmanship.  Blast Log Ltd 
undertakes to repair or replace free of charge, any part of the FM 301 unit, provide that the unit 
has been used in accordance with Blast Log’s published specifications and the operator’s 
manual. This warranty is void if the equipment has been neglected, dismantled, altered or 
abused in any way. Any transportation charges back to the Blast Log office to be payable by the 
customer. However on receipt of shipping documentation relating to the FM 301 unit, these 
costs will be refunded by Blast Log Limited. All transport costs relating to return of the unit will 
be payable by Blast Log Limited.  

It should be borne in mind that the FM 301 blasters’ seismograph is an electronic instrument. 
Although the unit is robust, in that it has been specifically designed for field use, it contains 
sensitive components which cannot be expected to withstand the same stress and shock as 
construction tools or heavy machinery. The battery is not intended to be replaced by the 
operator. The unit should be returned to Blast Log Limited to be serviced. Any attempt to service 
this product will void any and all warranties offered by Blast Log Limited. 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

tel  

e-mail 
 

web 

  
  Alberma House   

30 Grovehall Parade   
Beeston, Leeds   
West Yorks., LS11 7AE   
+44 (0)1 133 859870   
info@blastlog.co.uk 
 

   

  

www. blastlog.co.uk   

Leeds Office:   


	1. Front Cover
	2. Contents
	3. Instruction manual
	Chapter 1 – Introduction
	Handling Procedures
	Vibration Sensors
	USB Interface
	Bluetooth
	Battery Life
	GPS
	Internal Storage
	Dimensions and Weight
	Mounting
	LED Indicators

	Chapter 2 – Charging
	Charging the seismograph

	Chapter 3 – FM 301 Operations
	Setup Monitoring Parameters
	Field Setup
	Monitoring Start
	Initial LED Indications
	Monitoring Process
	Monitoring End

	Chapter 4 – V-Blast Windows Software
	Connecting via a USB Port
	Setting the FM 301 into USB Communication Mode
	Running the V-Blast software
	File :  Open
	Download
	Setup :  Seismograph
	Setup :  Software
	Waveform Display
	Printer Icon
	Magnifying Glass Icon – Zoom Function
	Frequency Analysis
	Filter


	Chapter 5 – FM 301 Android App
	Downloading and installing FM Seismograph App
	Using the FM Seismograph App
	Connect to FM 301
	Disconnect from FM 301
	Update Log and Status Screens
	Adjust Trigger Levels
	Disabling Trigger
	Send Results by Text Message
	View Location on a Map
	Close Application
	Adjust App Settings


	Appendix 1 – Specifications
	FM 301 Specifications
	Data Channels
	Acceleration Frequency Response
	Air Overpressure Frequency Response
	Resolutions (nominal and subject to calibration)
	Ranges
	Triggering
	Pre-Trigger Recording
	Recording Windows
	Storage Capacity
	Clock
	Interfaces
	Integrated GNSS
	Bluetooth
	Dimensions
	Weight

	V-Blast Specifications
	Minimum Requirements
	International Vibration Monitoring Standards Included
	International Air Overpressure Monitoring Standards Included
	Velocity Frequency Damage Criteria Included

	FM Seismograph App Specifications
	Minimum Requirements



	4. Warranty
	Blast Log FM 301 Blasters’ Seismograph Warranty

	5. Back cover

